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1 Executive Summary 

This document presents the status of the work under Work Package 5 (WP5) – 3D Artefact 

Processing - at the end of the fourth year of activity of the 3D-COFORM project. 

The activities followed smoothly the original plan drafted in the project Description of Work 

(DoW). Year 4 has been a period for performing the final assessments and making the final 

changes (bug fixing, modifications requested by user, etc.) for most of the tools developed in 

WP5, including the activities related to the delivery of final releases of all the tools. In some 

cases, we also had technical improvements (e.g. T5.1, T5.3).  

Major activities performed and results obtained in the fourth year are: the final version of 

MeshLab, which includes now a complete colour processing and mapping pipeline, an 

improved core and a searching mechanism to improve usability; the delivery of the shape 

analysis component; a finalized processing pipeline for the procedural modelling of landmark 

buildings; finally, an improved status of the research on fitting and measuring digital 3D 

models. 

No major problems or major deviations arose during the fourth project year. 

The overall organization of the document is as follows. Section 2 gives the usual brief 

presentation of the project structure, how WP5 activities and tools are located in the overall 

framework of the project, and relationships of WP5 components with respect to the other 

components developed in 3D-COFORM. Sections 3, 4 and 5 present in detail the work done and 

the results obtained in the three tasks of WP5 in Year 4. Section 6 reports on the milestones; 

some concluding remarks are presented in Section 7. Finally, the publications produced in Year 

4 are listed in Section 8. 
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2 WP 5 – 3D Artefact Processing - General 

description of work  

The 3D-COFORM framework and its components have been divided into four clusters:  

1. Acquiring and Processing (A&P), encompassing the developments in WP4/WP5  

2. Integrated Viewer/Browser (IVB), encompassing the developments in WP6/WP7  

3. Modelling and Presenting (M&P), encompassing the developments in WP8/WP9  

4. Repository Infrastructure (RI), encompassing the developments in WP3  

The central topic of WP5 is shape processing and analysis. On one side, transforming sampled 

raw data into high quality digital representations (i.e. all the geometric algorithms needed to 

process raw data and geometry-based representations); on the other side, developing a 

number of functionalities (segmentation, feature detection, component matching) which allow 

structuring of the geometric data making it possible to implement more sophisticated shape 

analysis or detect semantic correspondences between different shapes or sections of a given 

model. In the latter case, an important contribution will be a methodology for turning 3D 

reconstructions into procedural models.  

All tools interoperate with the repository (WP3): input data will be read from the repository 

(retrieved) and modified models will be uploaded back (ingested, which will include storing 

back both geometry and provenance data). 

In most cases, input data for the tools designed in WP5 are:  

 raw data coming from 3D scanning devices or from ARC 3D (production of raw 3D data 

from images), stored in the Repository Infrastructure; 

 3D meshes of whichever origin, also stored in the Repository Infrastructure. 

The Repository Infrastructure is therefore the common data source for all the components and 

algorithms designed and implemented in WP5. It is also the sink used by all of the WP5 

components for uploading the results produced after processing the input data, enriched by 

the related provenance metadata that will encode the specific processing action executed over 

the 3D data. 

The components designed and implemented in WP5 were initially described in deliverable D3.1 

– First Year Report on WP3 – Repository Infrastructure, where the reader can find a detailed 

description of all the inter-components interactions; functional specifications were also 

presented in that report.  



3D-COFORM D.5.4 (PUBLIC) 

7 

 

 

2.1 Task organization and planned work 

The activity of WP5 is subdivided into three tasks. The activity planned in the fourth year for 

the three tasks has been defined in the Description of Work (DoW) document as follows: 

Task 5.1 – Processing tools for mesh-based models 

 MeshLab: delivery of the final release of MeshLab and of the final documentation.  

Task 5.2 – Methods for shape analysis  

 Shape Analysis Component: delivery of the final release and of the final documentation.  

Task 5.3 - Fitting procedural models to classify acquired 3D models 

 Release the final version and of the final documentation.  

2.2 Work performed 

The work performed in the fourth year of activity is described in the following chapters, 

focusing on each single Task. 
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3 Task 5.1 – Processing tools for mesh-based 

models 

3.1 Activities and results in Year 3 

According to what was stated in the Description of Work (DoW) and deliverable D5.3 (Third 

Year Report), the expected objectives of Task 5.1 in Year 4 were declared as follows:  

 New versions of MeshLab will be delivered during the fourth year. The colour projection 

pipeline will be further improved, by adding the correspondences based image 

alignment and new mechanisms to improve colour projection (stencil quality masks, 

preservation of fine colour details). 

 Watermarking filter: debugging and testing will continue during the last year of the 

project. 

 Colour mapping feature (Breuckmann software): the implementation of the new colour 

mapping features will be finalized in Year 4. 

Progress achieved in the fourth project year is described in the following sections. 

  

3.2 MeshLab 

3.2.1 Further development of MeshLab by CNR-ISTI 

The fourth project year was not only a year devoted to debugging, fixing and dissemination. 

CNR-ISTI continued to work on the evolution and improvement of MeshLab, by following the 

initial plan but also by adding new work which resulted from user requests or from new ideas 

of the MeshLab design staff. We introduced: new features in the MeshLab core, new tools for 

point cloud management and, finally, consolidated the colour mapping pipeline (by exposing an 

additional filter to obtain an automatic parameterization and texturing of a 3D model starting 

from a set of registered images). All these new features had been released along with MeshLab 

1.3.2 in August 2012. We present them in more detail in the following. 
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New MeshLab core features 

The number of plugins included in MeshLab increased significantly in the past years. If we 

consider usability we might say this number increased excessively making the learning ramp 

steeper. MeshLab vers.1.0 released in March 2007 included only 15 plugins. In MeshLab 1.3.2 

the plugins number reached 70 with more than 250 filters exposed. These numbers strongly 

influence the usability of MeshLab, causing an overcrowding in the MeshLab menus, especially 

in the Filters one. A beginner user of MeshLab could easily feel disoriented while browsing the 

MeshLab menus, wasting an amount of time only searching for the desired feature.  

 

 

 

 

Figure 1: A MeshLab menu could discourage a not-expert user (left-most image). The SearchBox tool 

(right) 
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In order to significantly improve the MeshLab usability a new search tool (SearchBox) has been 

introduced in MeshLab 1.3.2, to allow the user to search for a filter by just typing a few 

terms/words in natural language.  

SearchBox does not index only the menu labels containing the filters name, but also the 

additional textual information provided by the filter author, e.g. comments explaining what the 

filter is intended to do. In this way it can be also used as a feasible tool for a not-expert 

MeshLab user to discover features supported by MeshLab.  

As an example, Figure 1 shows a MeshLab user looking for a simplification algorithm that they 

want to apply to a loaded mesh. Unfortunately, the overcrowded Remeshing, Simplification 

and Recostruction menu could generate a sense of loss to the not-expert user. Using the 

SearchBox tool (typing just "simplif") the user can easily find all the simplification algorithms 

exposed by MeshLab, discovering also that the Quadric Edge Collapse Decimation filter could 

be useful for their purposes.  

 

Figure 2: RealTimeLog can be used both to provide info on a mesh and/or to give an on screen 

help to the plugin user. 
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A new on-screen real time logger system (RealTimeLog) has been also introduced in MeshLab 

1.3.2. The RealTimeLog is a useful mechanism to easily provide to the user dynamic on-screen 

information on the mesh attributes as the mesh process evolves. All the information presented 

inside the RealTimeLog is automatically updated by the MeshLab core every time that a mesh 

element changes. More than one RealTimeLog can be contemporarily present on the MeshLab 

rendering area; each one providing information on a different mesh attribute (Figure 2).  

The RealTimeLog is a valuable tool for MeshLab plugin developers, assisting them in the plugin 

debug process. It is also useful as a means to provide an immediate on screen help to the 

plugin users.    

 

Colour Pipeline 

The colour pipeline is composed of a chain of tools intended to align a set of photographic 

images to a mesh and to transfer the retrieved colour information contained in the 

photographs onto the 3D model.   

The colour pipeline was released for the first time along with MeshLab 1.3.1, but was not 

complete. Then, the pipeline was deeply consolidated and expanded in MeshLab 1.3.2, by 

adding a new 3D model parameterization tool (the ParaTex filter).  

The “colour pipeline” now includes: 

 An image alignment tool, the MutualInfo filter that uses a statistical method to 

compute the alignment starting from an initial position provided by the user. 

 A simple tool, SetRaster, to manually assign a set of camera parameters to a Raster 

layer. 

 A colour projection filter, ProjectColor, which is based on the Masked Photo Blending 

approach [R T5.1.1]. It assigns a colour value to each portion of the surface which is a 

weighted sum of the contribution of all the images which map on it. The filter can 

encode the colour information both as a colour-per-vertex and as texture mapping 

(provided that a parameterization is available in advance) 

 The new colour projection tool, ParaTex, follows a different paradigm (see the paper 

produced in WP4 [T4.2.1]): each portion of the surface is assigned to a single image, 

the one which has the best quality for projection. The subdivision in patches of the 

surface automatically provides a parameterization of the model. The differences 

between adjacent patches are blended to obtain a continuous colour. This tool allows 

preservation of the fine details of colour information, and it provides the best results 

when a small number of images has to be mapped on a model. 
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Dissemination and training has been a primary objective also in Year 4. A new set of video 

tutorials, covering all the filters in the colour pipeline, was produced and distributed to the 

community to support self-tutoring of the new MeshLab features and to support dissemination 

(see at: http://www.youtube.com/user/mrpmeshlabtutorials?feature=results_main ). 

 

 

Point Cloud Management 

Two new tools have been added in MeshLab 1.3.2 to provide improved management of point 

clouds. Those tools focus on the easier selection of a subset of 3D points contained in a point 

cloud: 

 A tool, VertClusterSelection, able to select a cluster of vertices whose distance is less 

than a given threshold value in a user defined disk area (Figure 3, left).  

 A tool, VertPlaneSelection, able to select all the vertices such that: 

o given a plane defined by the normal vector computed on the point picked by 

the user, 

o the subset will contain all points whose distance from the above plane is less 

than a given threshold value (Figure 3, right). 

 

 

 

Figure 3: VertClusterSelection tool(left), VertPlaneSelection(right) 

http://www.youtube.com/user/mrpmeshlabtutorials?feature=results_main
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The MeshLab team also started an integration effort between MeshLab and the Point Cloud 

Library (PCL, http://www.pointclouds.org), a standalone, large scale, open project for 2D/3D 

image and point cloud management. The aim is to allow the PCL users and developers to easily 

create MeshLab plugins exposing the wide range of point processing algorithms contained 

inside the Point Cloud Library. 

 
 
 
MeshLab for tablet/smartphone platforms  
 
There was continued development of the MeshLab version for smartphones and tablets, 
started in Year 3. Due to the emergence and high user interest in the tablet platform, it was 
decided as a side activity to design and distribute a reduced MeshLab version for that domain.  
 
The mobile version of MeshLab includes only the visualization features (i.e. a mesh/pointset 
browser, rather than a modelling tool). The first MeshLab for IOS devices was released at the 
end of Year 3 (Sept. 2011, http://www.meshpad.org/), and is available on the AppStore and 
was already demonstrated at VAST 2011.  
 
An updated version was released in October 20121, that includes some optimization of the 
rendering engine, bug fixing,  the support of textured models, inclusion of CTM format, support 
of the new iPad and iPhone (retina display).  
 
The next version of MeshLab for iOS will include a multi-resolution rendering engine based on 
CNR nexus approach developed in WP9 (it is already working in beta version, for internal use 
and test).   
 
On July 2012 the first version was delivered for the Android platform (see: 
https://play.google.com/store/apps/details?id=it.isticnr.meshlab&hl=en ).  

Please note that CNR has NOT charged to the 3D-COFORM budget the development costs of 

this activity (it is funded by means of internal CNR resources). However, we consider it 

worthwhile to add it to the report, since this system has been used in the project dissemination 

and is a by-product of the technical activities funded by 3D-COFORM.  

 

MeshLab Distribution and success 

The number of downloads is a numeric indication of the success and penetration of MeshLab. 

                                                           
1
 This is the planned release date; at the moment of writing the report the delivery has not yet been 

finalized. 

http://www.pointclouds.org/
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 in the period Jan.-Oct. 2012 there were 200,038 downloads of the official releases 

(please note that this figure does not include the downloads of beta releases and the 

MeshLab units distributed with Linux distribution packages); 

 in the entire 2011 there were 164,340 downloads of the official releases  + 6,507 

downloads of the beta releases; 

 the total number of downloads so far is around 600,000; 

 the forecast for the entire 2012 downloads is 250,000 units. 

The graph in Figure 4 shows the increasing popularity of MeshLab, which corresponds to the 

appearance of the new functionalities and redesign originated by the 3D-COFORM project: 

roughly, design of new components (WP4 and WP5) in 2009-2010 and, later on, 2011; 

production of new versions in 2010-2011-2012, with an impressive increase of interest in 2011 

and 2012. 

 

 

Another success indicator is the number of scientific papers that cite or mention MeshLab. A 

search on Google Scholar (Oct. 2012) reports 714 papers mentioning MeshLab. 

Figure 4: Graph of MeshLab downloads (note that the 2012 figure is related to the first 10 

months only; the forecast for the entire 2012 is 250,000 downloads). 
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Dissemination activity 

The new features contained in MeshLab 1.3.2 have been presented in several contexts, e.g.: 

 the CAA 2012 conference in Southampton (UK), 

https://www.ocs.soton.ac.uk/index.php/CAA/2012/paper/view/532 ; 

 the "Low Cost 3D" Workshop in Trento (Italy), http://3dom.fbk.eu/files/lc3d/Ranzuglia-

Dellepiane_lowcost3d-2012-Trento.pdf ; 

 the “3D Graphics for Cultural Heritage” PhD course presented at the Institute for 

Advanced Studies (IMT, Lucca, Italy), April – July, 2012 

 the “Digital Cultural Heritage” Workshop in Nicosia (Cyprus), May 9-11, 2012 (joint 

activity with the EC NoE "V-Must" project) 

 the Summer School on "3D acquisition, processing and visualization" at Otranto 

(Italy), Sept. 10-22, 2012 

  “LinkSceem Thematic Workshop on Cultural Heritage” in Alexandria (Egypt), Sept. 23-26, 

2012 (joint activity with the EC NoE "V-Must" project) 

   

 

3.2.2 Contribution from Spheron to MeshLab 

Due to the challenging circumstances experienced by partner Spheron (described in detail in 

the global Year 4 Periodic Report), contribution to MeshLab by Spheron has not been finalized. 

Spheron has consequently not reported effort on this action in Year 4. 

 

3.2.3 Contribution from Breuckmann to MeshLab 

 
Within the 3D-COFORM project Breuckmann has developed a complete ADD-ON module for 
texture mapping (following the approach already introduced by CNR-ISTI in MeshLab, that has 
been a source of inspiration for the Breuckmann development); this software module will be 
integrated as beta-version into the next version the OPTOCAT software.  

The input data for the texture mapping are:  
- A 3D model with preliminary texture / colour information (colour is not required)  

- A set of 2D images to be mapped onto the 3D model  

https://www.ocs.soton.ac.uk/index.php/CAA/2012/paper/view/532
http://3dom.fbk.eu/files/lc3d/Ranzuglia-Dellepiane_lowcost3d-2012-Trento.pdf
http://3dom.fbk.eu/files/lc3d/Ranzuglia-Dellepiane_lowcost3d-2012-Trento.pdf
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- Parameters of the 2D camera  
 
There are two different modes available:  

- The 2D camera is already completely calibrated, i.e. all interior camera parameters, 
including the camera distortions, are known  

- The 2D camera is not yet calibrated.  
 
In this case at least the size of the camera chip must be known.  
The workflow for the texture mapping process comprises the following steps:  

- Loading all input data  

- An interactive pre-alignment of the 2D images. This is similar to the pre-alignment of 
single 3D scans: at least four corresponding points must be defined interactively in the 
3D model and the 2D image  

- An automatic fine alignment of the 2D images. This step also determines all necessary 
parameters of the 2D camera (interior and exterior)  

- Mapping the 2D images onto the 3D model  
 

As a result, a 3D model with enhanced colour information is available, which can be stored as 

PLY or optionally as OBJ-File ( in process) and can be visualized via MeshLab. 

 

3.2.4 Watermarking of 3D meshes 

 
The process of testing the 3D watermarking tool developed within T3.8 is continued during the 
fourth and last year of the project. Attention has been paid mainly to the crucial issues of 
robustness against changing topological connections. An updated version of the plug-in has 
been developed. 

Hereafter, a description of the whole final algorithm (embedding and detection phases) is 

reported: 

 

The embedding rule 

The watermarking embedding algorithm works according to two parameters: a secret key K 

and a coefficient γ determining the strength of the watermark. In particular, the following 

steps are performed: 

 A watermark-dependent structure called watermarking vector is generated according 
to K 

 A polar coordinate system is considered for the input mesh 

 The vertices of the mesh and the corresponding watermark element are used by the 
embedding algorithm to embed the watermark by altering the modulus of a subset of 
the FFT coefficients 
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 The watermarked FFT coefficients are used to reconstruct the watermarked model 

 

Watermark detection 

During the detection the user specifies the personal key K and the detector provides a positive 

or negative answer. To do so the watermarking vector is generated by starting from K, then the 

FFT transform of the modulus of each of the vertices are evaluated, and the correlation ρ 

between the watermarking signal and the FFT coefficients is calculated. If ρ is greater than a 

certain threshold Tρ the watermark is present, else the model is declared non-marked. The 

value of Tρ is obtained by means of statistical considerations. Specifically, the Neyman-Pearson 

criterion is adopted, which consists of maximizing the missed detection probability for a given 

probability of falsely revealing the watermark in a non-marked host. 

 
 

 

3.2.5 ARC 3D & MeshLab 

ARC 3D can now be used in two versions. A first possibility is that the user uses ARC 3D to 

create a separate depth map for each camera view and then exports those to MeshLab, where 

they are integrated into a complete model. This is the old way of using ARC 3D + MeshLab, 

which was finished and described earlier. Users often experience this as a rather tedious 

modus operandi, however. This feedback, combined with the fact that ARC 3D served as an 

example that spurred the creation of several similar, on-line services (often with a commercial 

component) has motivated special emphasis to be placed on the reinforcement of ARC 3D. 

These efforts have been reported in previous reports, and have this year been extended with 

the creation of better texture map, the details of which are described in WP4. Several use 

cases have been defined to guide these developments based on user feedback and constraints. 

The newer version of ARC 3D supports the automated integration of the different depth maps, 

carried out automatically by ARC 3D directly. The output of the new ARC 3D pipeline is a 

complete and integrated mesh stored in a format compatible with MeshLab (using OBJ 

format).  This means that this complete model can now be directly loaded into MeshLab, 

without the necessity of a conversion plug-in. The user can therefore still use MeshLab to 

further refine the ARC 3D model. In addition, the individual depth maps are still provided which 

can be loaded with the existing plug-in. Meshlab is now solely relied on for mesh viewing and 

processing, so the development and support of the stand-alone ARC 3D viewer has been 

discontinued.  
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3.3 Synthetic description of partners contributions 

Contributions of partners to T5.1 activities and results have been as follows: 

 CNR-ISTI: MeshLab has been extended, tested, disseminated; the final version was 

delivered. 

 MICC:  An updated version of the plug-in has been developed. 

 KUL: A new version of ARC 3D has been finalized and deployed, supporting automated 

depth map integration and yielding models compatible with MeshLab.  

 Spheron: has not reported work on MeshLab in Year 4. 

 Breuckmann: Contributed with a new colour mapping solution. 

 

3.4 Deviation from work plan 

No deviations from the work plan have been registered for Task 5.1. 
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4 Task 5.2 – Methods for shape analysis 

4.1 Activities and results in Year 3 

According to what was stated in the DoW and deliverable D5.3 (Third Year Report), the 

expected objectives of Task 5.2 in Year 4 were declared as follows:  

 Shape Analysis Component: The combination of segmentation algorithms will be 

completed in the following period of the project. Additional testing exercises will be 

carried out and the enterprise activities will actively be supported. 

 Sampled models completion: activity completed in Year 2. 

 CityEngine - Semantic LoD Rendering: Completion of integration and final testing of the 

integrated tool. 

The progress achieved in the fourth project year is described in the following sections. 

  

4.2 Shape Analysis component  

The technical effort for the fourth and final year of the project was focused on serving the 

practitioners in their real environment and within the established workflows. Thus, the 

development in this period addressed these requirements rather than new risky and unstable 

features. This was realized by means of re-directing some of the technical resources, in order 

to consolidate the more matured and promising components. In the context of this prioritizing 

process, Fraunhofer decided to reallocate 8 PMs from Task 5.2 (Fraunhofer originally had 26 

PMs, reducing its overall effort to 18 PMs), in order to strengthen the development of the 

Integrated Viewer / Browser (IVB). In other words, Fraunhofer’s effort in Task 6.2 (3D 

Annotating) was increased by 4 PMs from 12 PMs to 16 PMs and Fraunhofer’s effort in Task 7.1 

(3D Viewing) was increased by 4 PMs from 18 PMs to 22 PMs. It is important to note that 

Fraunhofer’s effort in Task 7.1 and Task 7.2 was merged into Task 7.1 after the second review, 

because of the change of responsibilities in the framework of the IVB between CNR-ISTI and 

Fraunhofer. 

Nonetheless, the remaining Fraunhofer’s effort in Task 5.2 (i.e. 2.68 PMs) was carefully 

planned, by means of collecting users’ feedback, for which the shape analysis tool was 

presented to and tested by several CH professionals and technicians in the context of 3D 

semantic enrichment: 
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 Workshop on 3D Heritage on the Mobile Web, Feb. 7-8, 2012, Brighton, UK 

 Testing Workshop at the Victoria and Albert Museum, Jun. 25-26, 2012, London, UK 

 German National Summer School 2012, Sep. 3-4, 2012, Schmitten, Germany 

The results of these exercises revealed that the support of the tool during the geometric 

definition for the 3D annotation by means of manual segmentation are appropriate for CH 

activities, where the professionals analyse the model in detail. An automatic enrichment is still 

a difficult task, since the professionals have also different expectations for the same CH 

artefact. Thus, in order to avoid risky and unstable development toward automatic enrichment, 

the progress in the final period aimed to assist the annotation process, by means of analysing 

the shape from a geometrical point of view for the propagation of annotations.  

For different reasons, the RI can store several different digital representations of the same CH 

artefact (master model, simplified derived models or edited ones, partial representation such 

as just the head of a full-body statue, etc.) When the user defines an Area on just one of those 

representations (e.g. selecting the nose to add some semantic information to this region), the 

capability of propagating this annotation to the corresponding region in all the other digital 

representations that depict the same artefact is an important feature. 

The semantic propagation is the action of sharing already created annotations between 

different digital 3D representations of the same CH artefact. From a semantic point of view, the 

UUID of the primary Area is shared with the corresponding Area on the corresponding different 

representations, but being considered as a propagated Area. However, from a geometric point 

of view, the propagation might be challenging, since a different resolution, a different scaling, 

or a different orientation could prevent the direct transformation of the Area. Thus, the first 

step aims to find the corresponding transformation between the two digital representations, in 

order to apply it to the Area to be propagated (see Figure 5). 

 

Figure 5: The geometric propagation of an Area: transformation between two abstract shapes 

with different orientation and scale. 
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Since the propagation is triggered by the user and there is no previous information about the 

correspondence between the two digital representations, a timesaving algorithm is required, in 

order to be executed during the enrichment process and in an interactive manner, while 

providing an educated guess of the needed transformation. The transformation is found by 

calculating a characteristic vector (Figure 6) for each shape and then by computing the 

corresponding rotation, scale and translation matrices between both vectors.  

 

The final transformation matrix (Figure 7) is applied to the Area to be propagated, which is 

then transformed according to the characteristics of the other shape. The algorithm properly 

enables the computation of the correspondence between the two shapes, given that the shape 

is not symmetric and that the scale between the two digital representations is isotropic. These 

two conditions are common properties of digital CH artefacts; thus, the algorithm generates 

the expected results in most of the cases. 

Figure 6: The Geometric propagation of an Area: calculation of the characteristic vector of a 

shape. 
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The results presented in the context of the shape analysis tool have been submitted to 

different conferences and journals, where the analyses of 3D shapes and the extraction of 

semantics, as well as the combination of both by means of annotations, has been 

demonstrated to be very relevant for the intelligent use of digital representations within 3D CH 

collections (see publications [T5.2.1], [T5.2.2], [T5.2.3]). 

 

4.3 Tools for completing sampled representations 

This activity was terminated in Year 2. 

 

 

4.4 CityEngine - Semantic LoD Rendering  

The goal of this task was to exploit the structural descriptions of CityEngine models to arrive at 

a more effective and satisfactory production of different levels of detail for the models. The 

different levels should be more compact yet still look more detailed and realistic compared to 

the current, mainly bottom-up LoD methods. 

The direct implementation of this paper into the 3D-COFORM infrastructure cannot be done 

because of technical and legal issues. We therefore announced a change of plan and 

implemented the CityEngine-on-the-server solution with a VSL node and integration into 

CorExplorer/Viewer Browser for this. This was already shown in the demo of the Year 3 review 

in Feb 2012. 

Figure 7: The Geometric propagation of an Area:  computation of the transformation matrix. 
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No effort has been charged on this activity in Year 4 by the assigned partner. 

 

4.5 Synthetic description of partners contributions 

Contributions of partners to T5.2 activities and results have been as follows: 

 FhG-IGD: Extensively tested the annotation component with CH practitioners and 

extended it by considering the propagation issue among different representations of the 

same artwork 

 CNR-ISTI: activity in T5.2 was completed in Year 2 

 ETHZ: activity was completed 

4.6 Deviation from work plan 

No deviations from the work plan have been registered for T5.2. 

CityEngine has been acquired by a private company (ESRI). Therefore, some components of the 

tool will reside in Virtual machines within the company and provide remote service as 

explained. This does not interfere with the results of integration.  
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5 Task 5.3 – Fitting procedural models to classify 

acquired 3D artefacts 

The goal of this task is to devise new geometric processing solutions that will allow the creation 

of synthetic digital models based on procedural or functional approaches, starting from 

available digital data sources (plans, images, sampled 3D models). 

 

5.1 Activities and results in Year 3 

According to what was stated in the DoW and deliverable D5.3 (Third Year Report), the 

expected objectives of Task 5.3 in Year 4 were declared as follows:  

Image-based inverse procedural modelling tool:  

 integrate the tool with the RI, 

 implement the automatic procedural modelling of facades tool as well as an automatic 

segmentation tool, 

 learn a style grammar from examples, 

 reconstruct Regency style buildings. 

User assisted procedural shape fitting as 3D measuring tool:  

Based on the existing prototypes for measurement primitives (from Year 2) and the user-

assisted fitting, we plan to pursue the following goals: 

 Implement the existing list of basic shape detectors and measurement operations and 

extend them as required by the users 

 Extend the user-assisted fitting prototype with algorithms from Torsten Ullrich’s PhD 

thesis and make them available in the interactive context 

 Full RI integration including retrieval of stored 3D models for input data and storing 

results as metadata 

 Provide an appropriate, Qt-based GUI for the user-guided measuring and fitting 

algorithms that can be further integrated into the IVB 

The progress achieved in the fourth project year is described in the following sections. 
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5.2 Procedural Modelling of Landmark Buildings 

In Year 4, in keeping with the above goals, three tasks were performed:  

1. the integration of the inverse procedural modelling tool with the RI; 

2. an automated façade parsing tool (semantic segmentations are demonstrated on 

Hausmannian style buildings, which constitute a large part of some historical city 

centres);   

3. automatic style grammar learning.  

These tasks are elaborated below. 

5.2.1 Integration with the RI 

The inverse procedural modelling tool was integrated with the RI via CityEngine. Given a 

picture and the segmentation of a façade into its semantic components (windows, doors, 

balconies, etc.), this tool generates a set of procedural rules and parameters which can be 

rendered in the CityEngine. The integration of the inverse procedural modelling tool in 

CityEngine allows the user to visualize and edit the rules before exporting the 3D model onto 

the RI. First, a picture of a facade and its corresponding segmentation are retrieved from the 

RI. Then, automatic inverse procedural modelling is performed. The corresponding inferred 

rule set and 3D model are fed to CityEngine. Once the user is happy with the result, they can 

ingest the 3D model onto the RI (see Figure 8).   

 

Figure 8: Ingestion of the 3D model using CityEngine 3D-COFORM edition. 
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5.2.2 Automatic segmentation of façades 

We present two approaches for façade segmentation:  

 (Approach 1) Combining Recursive Neural Network segmentations, detections and weak 

architectural knowledge 

A method (see publication [T5.3.1]) to segment building façades into their semantic 

components was devised and tested on the Hausmannian façade, made publicly available by 

the Ecole Centrale Paris (ECP) (see Figure 9). It has to be noted that quite some effort went into 

correcting the ground truth for this dataset, as the one provided by ECP contains some 

important errors (as the “ground truth” was forced to live within the space of an overly 

confined grammar for the Hausmannian style).                  

A 3-layer approach has been developed. A first layer uses a bottom-up style segmentation as 

usual (using mainly colour and texture cues). A second layer adds influences coming from top-

down façade component detectors (e.g. for windows or doors). This addition already has a 

positive effect on the segmentation. Finally, in a third layer, weak architectural preferences are 

encouraged (and not imposed). Examples of the latter are the vertical and horizontal alignment 

of components, the repetition of similar components, or the existence of symmetries. The 

three layers are all fused in a principled way. For instance, a Markov Random Field fuses the 

data obtained from the layer-1 bottom-up segmentation with the responses of top-down, 

specialized detectors. Weak architectural principles are introduced to enhance the results and 

make sure the segmentation is consistent. The result of this façade parsing scheme is that a 

procedural model is inferred. 

Compared to previous work, results outperforming the state-of-the-art (see reference [T5.3.1]) 

can be achieved without using a style-specific, hand-designed set of rules. Starting from a style-

specific grammar was the original plan. Yet, such grammars are not easy to come by. When 

hand-generated, they also easily end up being either too broad or too restrictive.  

Instead, we show that both the rules and parameters of a procedural model can be inferred 

from the segmentations. Replacing imposed, style-specific grammars by encouraged, weak 

rules has been proven feasible by our work. The result is an automatically produced series of 

sparse facades. These can then be used to automatically extract more stringent rules for the 

corresponding style, containing precise statistics where alternative rules can be applied. This 

means that we have found a way to automatically generate style-specific grammars (albeit 

generated in a less human-friendly format, i.e. as a possibly long enumeration of observed 

component conjunctions). As soon as these have been generated, the system can bootstrap 

itself to use such stronger grammars to handle future instances (as shown in the past, styles 

can be automatically recognised through the use of rather simple features). Similarly, once 

façades of the same style have been parsed, it is perfectly possible to further bootstrap the 

system by also learning style-specific detectors for windows, doors, etc.  
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(Approach 2) Learning Visual Information and Architectural Principles Simultaneously 

So far, it has been proposed to exploit human-generated, weak architectural principles, to then 

allow the system to automatically learn a style-specific grammar (see Figure 10). Yet, this begs 

the question, whether it is not possible to also automatically derive these weak principles, or – 

as a more modest research program – to automatically gauge their relative importance. This 

would take the limitation of human imagination / interference out of the equation… at least in 

part.  

A façade labelling method (see publication [T5.3.2]) that can learn the visual information and 

architectural principles together has been developed. Façade labelling should on the one hand 

conform to visual information, and on the other hand to the architectural principles.  To this 

end, we identified a set of meta-features, which capture both visual evidence and architectural 

rules, and learned their contributions to the final façade labelling model.   

The defined features include a more exhaustive set: support strength from visual recognizer, 

support strength from image edges, similarity score of the same building assets, balance score 

among different assets, balance score among different neighbouring relationships, regularity 

score of assets’ shape, alignment score of building assets, regularity score of the distribution of 

building assets, etc. The weights of the features are learned by a principled max-margin 

learning method. As a matter of fact, the learned parameter vector can already be taken as a 

quantization of façade style and can be used for both façade labelling and façade style 

recognition.  Compared to [T5.3.2], this work learns the contributions of visual evidence and 

different architectural rules at the same time from the data, instead of using weak 

architectural rules to post refine the results of visual recognition, and the learned models can 

also be used for façade style recognition (as an alternative approach for the style classifiers 

Figure 9: Original picture (left) and corresponding segmentation (right) of facades in rue 

Monge, from the ECP dataset. (Red: window, purple: balcony, yellow: wall, green: shop, dark 

blue: roof, light blue: sky) 
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proposed in the past). The drawback of this work is that it needs more precise human-labelled 

images during training. In experiments, it was found that the learned architectural principles 

contribute a lot to the final results (see Figure 10), which is comparable to that of the method 

[T5.3.1]. 

  

 

5.2.3 Learning a style grammar from examples 

In this section, two approaches for learning style grammars are introduced, which are 

described in more detail in D5.4_Appendix. The goal is to learn a grammar from labelled 

façade images (through a parsing method as already discussed). So far, style grammars have 

been manually written and the motivation is to reduce the amount of work and ensure 

consistency of the style grammars. Style grammars have been used in two domains: vision and 

graphics.  The first method aims at producing a "graphics-oriented" style grammar for 

rendering, editing, new building generation and comparison; the second method aims at 

producing a "vision-oriented" style grammar to support facade parsing and serves as an 

alternative to hand-written shape grammar priors. 

(See the Appendix in document D5.4_Appendix - non-public section of the report) 

 

 

Figure 10: Results from the method presented in publication [T5.3.2]: from left to right, they are 

a façade image, its segmentation result, its labelling result without learning the architectural 

principles, and its labelling result after learning the architectural principles. 
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5.2.4 Inverse procedural modelling—documentation   

 

Features 

The Inverse Procedural Modelling tool allows automatic creation of a procedural model 

without any knowledge about Procedural Modelling. The Inverse Procedural Modelling (IPM) 

tool interface is based on CityEngine 3D-COFORM edition. It offers all the functionalities of 

CityEngine, whose manual can be found under its Help menu. 

• All features of CityEngine 

• Integration with the RI: ingestion and retrieval 

• Automatic Inverse Procedural Modelling of facades, starting from a labelled 

Hausmannian façade. 

 

Input 

As input, the tool takes a rectified picture of a façade and an associated Manhattan-world 

labelling. The formats are JPG for the façade picture and PNG for the labeling. 

The labeling uses the following colour codes: 

A number of HTML colour converters can be found on the Internet, for example: 

http://web.forret.com/tools/color.asp.  It is important that the given labelling exactly respects 

this colour code. 

Asset HTML colour code 

Sky #80ffff 

Wall #ffff00 

Window #ff0000 

Roof #0000ff 

Balcony #8000ff 

Shop #008000 

Door #ff8000 

http://web.forret.com/tools/color.asp
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Output 

The IPM tool produces a set of rules describing the given façade. 

 

How it works 

A procedural model consists of a set of rules which successively refine an initial shape. Given a 

façade labelling, the tool automatically finds a lossless decomposition of the façade. The more 

complex the façade, the more rules will be necessary to describe this façade. 

 

CityEngine 3D-COFORM edition 

Retrieval 

 

To retrieve façade data, select the image directory of the project, click on File > Import… > 3D-

COFORM > Retrieve Repository Object > Group Data (via <UUID>) and enter the desired UUID. 

Click Validate… and Finish (see Figure 11). For the IPM tool, two files (a JPG and a PNG) should 

appear in the image directory. 

 

 

 

Figure 11: Data retrieval wizard 
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Inverse Procedural Modelling Tool 

Once the rectified façade image and its labeling have been retrieved, the IPM tool can be 

executed under Scripts > facadeParsing. The resulting ruleset is generated and immediately 

rendered. 

 

Editing 

The obtained model can be kept as is or edited further. The generated ruleset can be found in 

the FacadeParsing project directory under rules>rule.cga. As with any CityEngine ruleset, the 

CGA file can be edited. When the façade is selected, the rule parameters can be found and 

edited on the right side. 

The interactive edition of the model gives immediate feedback to the user (see Figure 12). 

 

 

 

Ingestion 

Once satisfied, the resulting model can be exported. Click File > Export… > 3D-COFORM > Ingest 

Repository Object > Generate and Ingest Models as Group > Finish (see Figure 13). The model 

is ingested with the appropriate metadata. 

Figure 12: CityEngine interactive parameter edition panel 
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5.3 The Shape Dimensioning Toolkit (SDT) –Adaptable 3D 

Measurement Tool with User-Defined Procedural Shape 

Detectors 

The goal of this task is to create a “Shape Dimensioning Tool” that allows CH-professionals to 

obtain measurements of a digitized artifact much faster than by measuring the physical artifact 

by hand. Due to limited resources, during Year 3 the work on T5.3 had been merely conceptual, 

mainly leveraging on results from a PhD thesis on automatic shape fitting that was carried out 

during Year 3. In Year 4, the results were transferred into an interactive setting. 

 

5.3.1 Interactive Fitting Operators 

GPU-based fitting operators were implemented for primitive shapes (planes and spheres). Each 

fitting operator is based on a point-to-primitive distance function f(x, M(p)), where x denotes a 

three-dimensional point in Euclidean space and M(p) denotes the procedural primitive M 

instantiated with given parameter set p. These distance functions can be used to derive for 

instance the following error functions, representative of the full set of elementary shape 

descriptors (see deliverable D5.3): 

Figure 13:  Ingestion wizard 
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 Plane: 

 

 Sphere: 

 

Our interactive fitting operators are based on the following generic paradigm (see Figure 14): 

As input parameters, we expect an input point cloud (black dotted circle) and an initial set of 

procedural parameters (blue). Furthermore, this initial solution is assumed to be close enough 

to the optimum, so that it can be used to define a weighting function that excludes outliers 

from the subsequent optimization process. All points inside the tolerance region (left, shown in 

light blue), are accepted by the point selection step, while all other points are ignored for the 

optimization. The optimization process attempts to minimize the error function and uses a 

conjugate-gradient optimization based on finite differences. The result of this process is an 

optimized set of parameters p, so that M(p) matches the input point cloud as closely as 

possible as shown on the right side of Figure 14. The size of the tolerance region is left as a 

user-adjustable parameter to have explicit control of the “snapping” behavior of the fitting 

operators. 

  

 

The fitting operators were evaluated on different datasets to examine their stability and 

performance. The quality of the results remains stable for different noise levels and also when 

parts of the primitives are removed (e.g. only one half of a sphere). The overall performance is 

Figure 14: Input setting consisting of input point set and initial set of parameters (left), the 

fitting operator process chain (middle) and the result (right) 
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good for moderately sized datasets, but there is room for optimization with respect to the 

parallelization of the error function evaluation. Our experiments revealed that fitting is a task 

that is ideally suited for GPU parallelization, which is the key to interactive speed.  

 

                           

   

 

The current status is that the GPU-based fitting library is available as a C++ library that uses 

CUDA for the fitting process. The library is currently being wrapped as GML operators, which 

integrates it into the VSL framework. Using the VSL framework a visual interface will be created 

for the shape templates, which is currently missing. However, a set of interactive scene graph 

manipulation widgets integrated with the VSL have already been realized. As first application, a 

VSL-based alignment tool has been created that allows interactive definition of a standard pose 

for photogrammetrically reconstructed 3D-objects (ARC 3D) which are at a quite random pose 

(Figure 15). 

 

Figure 15: Interactive manipulation widgets in the VSL. Top: Scene graph node (translation, 

rotation about vertical axis), full rotation widget attached to scene graph node, scene graph 

hierarchy. Middle: ARC 3D reconstruction in arbitrary pose (left) is brought to standard pose 

(right). Bottom: Once objects are in standard position, they can be compared. 
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5.4 Synthetic description of partners contributions 

Contributions of partners to T5.3 activities and results have been as follows: 

 ETHZ: finalized the activity on Procedural Modelling of Landmark Building, by proposing 

new technical solutions and finalizing the development of the tool and its integration. 

 TUGraz: A set of elementary shape detectors is available with a GPU-based 

implementation and a C++ interface. They are available as GML operators which could be 

used to create hierarchical shape detectors (shape templates) for interactive shape 

dimensioning. 

 

5.5 Deviation from work plan 

Regarding the Image-based inverse procedural modelling tool, the important deviation has 

been that, instead of starting from a style-specific grammar as proposed in the DoW, weak 

architectural principles have been shown to effectively handle the problem and to yield the 

basis for the then automated extraction of such grammar. Thus, here the project has reached 

stronger goals than anticipated. 

Concerning the Shape Dimensioning Toolkit, the plan for Year 4 already foresaw a working 

software prototype for template-based shape fitting, with a visual interface based on VSL, and 

integrated with the repository infrastructure.  

The recommendation from the Year 3 review, however, was to prioritize tool maturity over 

developing new tools. So it was decided to prioritize infrastructure work, stabilizing the 

CorExplorer as the main tool for collection management, which is also indispensable work for 

reaching the goals in T5.3. As a result, the following has been achieved (a) the RI integration of 

the VSL (described in the WP9 deliverable D9.4) and (b) a library for visual interfacing with VSL 

scenes, which resulted in an interactive object alignment tool (see Figure 2). The following 

remain to be achieved: 

 the interactive creation and application of hierarchical shape templates, and  

 the automatic iterative fitting of hierarchical shape templates.  

There is confidence that this gap can be closed in the remaining time of the project, and the 

template-based fitting for shape dimensioning of models from the Eggenberg collection 

demonstrated. 
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6 Milestones 

The major milestones in the period considered are as follows:  

 MS5.6 – M42: All final versions of the tools are available for usage in WP12 and 13 

The tools have been finalised and tested extensively in Year 4 on a number of exploitation 

experiments; most of them, but not all, have been presented in the 3D-COFORM Exhibition in 

Brighton (July-August 2012). 

 

7 Conclusion 

The activities of WP5 are in line with the planned schedule proposed in the DoW document.  

A number of interesting results have been obtained at the algorithmic level (see the scientific 

publications produced in Year 4, listed in Section 8 below, and all of those presented in 

previous Years 1 -3). The planned milestones have been reached, with the exception of some 

minor adjustments in T5.3.  

We are proud to mention that thanks to the resources and development activities deployed in 

3D-COFORM, MeshLab reached a very consolidated status and became the main platform for 

sampled 3D data processing (covering now also sophisticated colour management, a feature 

that is very basic in competing commercial products); it totalled more than 200K downloads in 

the first 10 months of 2012 and has a user community of several tens of thousands. Some 

activity not planned in the DoW has been also contributed (e.g. MeshLab porting to the mobile 

platforms) to follow in a timely fashion the evolution of the market and users' requests.  

Other interesting results have been produced in the Shape Analysis task (tools for curvature-

driven segmentation, annotation and  propagation of the segmented/annotated content to 

other derived models representing the same artwork), that are now integrated with the 

repository and are now part of the only integrated platform supporting storing, search, 

retrieval and geometric analysis over sampled 3D models. 

Finally, the components for procedural modelling have been finalized, by delivering an 

innovative procedural modelling of landmark building and implementing the core of a 

measuring tool. 
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8 Publications  

 

T5.1 

[T5.1.1] Francesco Banterle, Massimiliano Corsini, Paolo Cignoni and Roberto Scopigno, "A 

Low-Memory, Straightforward and Fast Bilateral Filter Through Subsampling in Spatial 

Domain", COMPUTER GRAPHICS Forum, Volume 31 (2012), number 1 pp. 19–32. 

[T5.1.2] Matteo Dellepiane, Nicolo Dell Unto, Marco Callieri, Stefan Lindgren, Roberto 

Scopigno, "Archeological excavation monitoring using dense stereo matching techniques", 

accepted for publication on  Journal of Cultural Heritage, Elsevier,  Volume available online - 

2012 (in press). 

[T5.1.3] Fabio Ganovelli, Roberto Scopigno, "OCME: out-of-core Mesh Editing Made Practical", 

IEEE Computer Graphics and Applications, Volume 32, Number 3, page 46-58 - May/June 2012. 

[Note: this paper was already mentioned in the Year 3 WP5 report, but it was effectively 

published on 2012] 

[T5.1.4] Marco Callieri, Matteo Dellepiane, Guido Ranzuglia, Paolo Cignoni, Roberto Scopigno, 

"MeshLab as a complete open tool for the integration of photos and color with high-resolution 

3D geometry data" , CAA 2012 Conference Proc, Southampton (UK), 2012-03-26. 

 

T5.2 

[T5.2.1] Rodriguez-Echavarria K., Theodoridou M., Georgis C., Doerr M., Arnold D., Stork A., 

Pena Serna S.: "Semantically rich 3D documentation for the preservation of tangible heritage". 

VAST12: The 13th International Symposium on Virtual Reality, Archaeology and Intelligent 

Cultural Heritage. 

[T5.2.2] Pena Serna S., Schmedt H., Ritz M., Stork A.: "Interactive Semantic Enrichment of 3D 

Cultural Heritage Collections". VAST12: The 13th International Symposium on Virtual Reality, 

Archaeology and Intelligent Cultural Heritage. 

[T5.2.3] Pena Serna S., Scopigno R., Doerr M., Theodoridou M., Georgis C., Ponchio F., Stork A.: 

"Exploring and Enriching 3D Cultural Heritage Collections", In submission process to ACM 

Journal on Computing and Cultural Heritage. 
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T5.3 

[T5.3.1] A. Martinovic, M. Mathias, J. Weissenberg and L. Van Gool, "A Three-Layered 
Approach to Facade Parsing", European Conference on Computer Vision 2012, Florence 
(Italy), Oct. 7-13, 2012. 

[T5.3.2] D. Dai, M. Prasad, G. Schmitt, and L. Van Gool, "Learning Domain Knowledge for 
Facade Parsing", European Conference on Computer Vision 2012, Florence (Italy), Oct. 7-
13, 2012. 
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